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original adoption or, in the case of revision, the year of last revision. A number in parentheses indicates the year of last reapproval. A
superscript epsilon (´) indicates an editorial change since the last revision or reapproval.

1. Scope

1.1 This guide describes several measurement and technical
issues involved in quantifying the spread area of fixed cells.
Cell spreading and the distribution of cell spread areas of a
population of cells are the result of a biological response that
is dependent on intracellular signaling mechanisms and the
characteristics of cell adhesion to a surface. Cell spread area is
a morphological feature that can be responsive to alteration in
the metabolic state or the state of stress of the cells. Changes in
cell spread area can also indicate an alteration in the adhesion
substrate that may be due to differences in manufacturing of the
substrate material or be in response to extracellular matrix
secretions. High quality measurement of cell spread area can
serve as a useful metric for benchmarking and detecting
changes cell behavior under experimental conditions.

1.2 The measurement described in this document is based
on the use of fluorescence microscopy imaging of fixed cells
and the use of image analysis algorithms to extract relevant
data from the images. To produce robust cell spread area
measurements, technical details involved in sample
preparation, cell staining, microscopy imaging, image analysis
and statistical analysis should be considered. Several of these
issues are discussed within this document.

1.3 This standard is meant to serve as a guide for developing
methods to reliably measure the area to which cells spread at a
surface. This surface can be conventional tissue culture poly-
styrene or sophisticated engineered biomaterial surfaces. An
example of a detailed procedure to measure the spreading area
of cells on a tissue culture polystyrene surface is provided in
the appendix section.

1.4 Cell morphology features such as cell spreading area
and perimeter are generally reported in units of length. For
example, spreading area per cell (that is, cell spread area) is
likely reported in units of µm2. A spatial calibration standard is
required to convert between numbers of pixels in a CCD
camera image to µm2 as an SI unit.

1.5 This standard does not purport to address all of the
safety concerns, if any, associated with its use. It is the
responsibility of the user of this standard to establish appro-
priate safety and health practices and determine the applica-
bility of regulatory limitations prior to use.

1.5.1 Sodium azide is used as a anti-bacterial reagent in the
slide mounting media. This preserves the integrity of the
mounting media. The toxicity of this reagent (for example,
MSDS) should be considered before use of this reagent in large
scale slide mounting procedures.

2. Referenced Documents

2.1 ASTM Standards:
E1488 Guide for Statistical Procedures to Use in Developing

and Applying Test Methods
F2150 Guide for Characterization and Testing of Biomate-

rial Scaffolds Used in Tissue-Engineered Medical Prod-
ucts

3. Terminology

3.1 Definition of Terms:
3.1.1 cell morphology—the physical shape properties of a

cell such as cell volume, cell spread area, and cell perimeter;
and the non-unit measures of roundness and circularity.

3.1.2 cell spread area—the area that encompasses a
2-dimensional (2-D) projection of a 3-dimensional (3-D)
adhered cell.

3.1.3 cell object—a single cell or two or more adhered cells
adjacent to each other such that they cannot unambiguously be
segmented from one another by cell edge detection techniques.

3.2 Definitions of Terms Specific to This Standard:
3.2.1 segmentation—the act of classifying pixels in an

image as cell or non-cell areas and the grouping of adjacent cell
pixels into a cell object.

4. Summary of Practice

4.1 The measurement of a cell morphology feature such as
cell spread area in a population of cells in culture can be a
quantitative characteristic of cell population behavior and cell
population state. This document provides guidance on measur-
ing the 2-D morphological property (that is, cell spread area)
for a population of cells in culture on a material.

1 This test method is under the jurisdiction of ASTM Committee F04 on Medical
and Surgical Materials and Devices and is the direct responsibility of Subcommittee
F04.46 on Cell Signaling.
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4.2 This measurement is typically achieved by seeding a
population of cells at low density on a test surface and
chemically stabilizing the cellular structure by fixing the cells
at a particular point in time. The cells are then treated with two
stains: one that discriminates the cell from non-cell
background, and another that associates with the nucleus of the
cell. The dual-stained cells are then imaged with a fluorescence
microscope using a low magnification and a high numerical
aperture (NA) objective (for example, 10× magnification and
NA>0.25) that maximizes the number of cells in a single
image. The magnification and NA should provide sufficient
resolution to enable accurate counting of the numbers of pixels
associated with a cell, and allow large numbers of cells to be
imaged, thus providing robust population statistics. Images of
both the nuclei and corresponding cellular areas are collected.
These images are then processed and analyzed by image
analysis software to achieve both segmentation of the cell
objects from the non-cell background to allow quantification of
cell object spread areas, and segmentation of nuclei for
determination of number of nuclei in each cell object. These
two metrics allow a value for spread area per cell to be
generated.

4.3 The spread area per cell measurement can be generated
for each cell or cluster of cells in an image. These data can be
parameterized as average spread area per cell or as a probabil-
ity distribution. Each of these reported values are characteris-
tics of the cell population adhered to a defined substrate.
Statistical methods applicable to average values or distribution
comparisons can be used to identify statistically significant
changes.

4.4 It is important to note that the cell spread area measure-
ment described here can be influenced by a large number of
experimental factors that can influence cell state and the
adhesion substrate. These include variations in reagents used
during culturing of cells (such as serum, substrate vendor,
media) and differences in how the cells are handled during
maintenance and storage. Significant robustness testing and
sensitivity analysis of these factors on the cell spread area
measurement will be required to develop this measurement into
a test method for benchmarking a particular cell culture
system.

5. Significance and Use

5.1 Under well-controlled conditions, the quantitative
evaluation of morphological features of a cell population can
be used to identify changes in cellular behavior or state. Cell
morphology changes may be expected when, for example,
there is a response to changes in cellular cytoskeleton organi-
zation (1), a response of cells to toxic compounds, changes in
differentiation state, and changes in adhesion properties of cells
to a substrate by either chemical or mechanical-induced
extracellular matrix-based (ECM-based) signaling pathways
(2, 3). Typically, populations of cells exhibit a range of
morphologies even when the cells are genetically identical and
are in a homogeneous environment (4). This biological varia-
tion in cell response is due to both cell-cycle variations and
stochasticity in the cellular reactions that control adhesion and
spreading in cells. By using cell-by-cell, microscopy-based

measurements and appropriate statistical sampling procedures,
the distribution of cell morphologies such as cell spreading
area per cell can be measured. This distribution is highly
characteristic of the culture and conditions being examined.

5.2 It is important to note that the use of this technique for
cells on or in a 3-D scaffold materials can complicate the
interpretation of the data. The topographic transforms of the
cells on a 3-D material may require full volumetric imaging
and not just wide-field fluorescence imaging as described here.

5.3 the following are several examples of how this measure-
ment can be used in a laboratory:—

5.3.1 Quantify Cellular Response to a Biomaterial—The
measurement of cell spread area can be used to characterize the
response of cells to biomaterials. For example, spreading of
most cell types is extremely sensitive to the stiffness of the
culture substrate (5), (6). It is important to note that cell
response to an ECM may be dependent on the preparation of
the matrix. For example, the same ECM proteins prepared in a
fibrillar or non-fibrillar surface coating can result in different
morphology response

5.3.2 Quality Control Metric for General Cell Culture
Conditions—Cell spread area may be a useful metric for
monitoring a change in cell culture conditions (that is, due to a
serum component, pH, passage number, confluence, etc.). Cell
morphology is often altered when cells are stressed and
proceeding through cell-death related processes (that is, apo-
toposis).

5.3.3 Quality Control Metric for Biomaterial Fabrication—
Cell spread area measurements may be useful for generating
specifications for a biomaterial. These specifications may
stipulate how a particular cell line responds to a fabricated
biomaterial.

5.3.4 Quality Control Metric for Cell Line Integrity and
Morphology Benchmarking—The morphology characteristic of
a cell line grown under specified conditions should ideally be
the same over time and in different laboratories. Thus, cell
spread area measurements may be useful for validating that no
significant changes in the cell cultures have occurred. This
measurement provides a benchmark that is useful for estab-
lishing the current state of the cell culture and a metric that can
be charted to increased confidence for within and between
laboratory comparisons of cellular measurements (7).

6. Test Considerations

6.1 Fluorophore Reagents:
6.1.1 For high quality cell morphology measurements, it is

important to collect images of both the cell spreading area and
images of the cell nuclei in corresponding frames. This allows
the calculation of the normalized metric, average spread area
per cell. An excellent method for collecting these images is
with two-color fluorescence microscopy imaging. Fluorescent
stains are used to highlight specific features of the cell. The use
of high quality cell stains will optimize the contrast differences
between the background and the cell features being probed.

6.1.2 It is critical that the cell feature stains exhibit high
signal-to-background ratios. For the case of cell edge detection
it is important to consider that the measurements are extracted
from cell images with image analysis procedures. Reliable cell
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edge detection algorithms function best with cells that exhibit
high-contrast edge staining around cell features (8). Several
cell stains (see Table 1) can be used to provide contrast at the
cell and nuclear edge. It is important to note that empirical
evaluation of samples treated with several stains may be
required to evaluate the best staining strategy that optimizes
cellular and nuclear edge detection (9). This is most important
for cell edge stains because nuclear stains such as 4’,6-
diamidino-2-phenylindole (DAPI) and Hoechst 33342 typi-
cally perform very well.

6.1.3 It is important to consider the spectral properties of the
stains that are used to identify the edge features and the nuclear
features of a cell. To retain independence between the cell
object area measurement and the nuclei count measurement, it
can be useful to minimize bleed-through fluorescence (often
termed crosstalk) between the nuclear stain and the cell object
stain. Bleed-through is minimized by choosing fluorophore
probes that have significantly different excitation and emission
properties. For example, if a nucleus was stained with Hoechst
33342 (exciting wavelength = 350 nm, emission wavelength =
461 nm) and the cell edge was stained with a Texas Red based
fluorophore (exciting wavelength = 590 nm, emission wave-
length = 620 nm), it is unlikely that the emission from the
Hoechst 33342 fluorophore would interfere with the respective
Texas Red fluorophore-based images. The appropriate control
for bleed-through is to evaluate a sample stained with only one
fluorophore in each filter channel at the appropriate integration
time, binning, and gain settings. Morphology measurements
from cell edge and nuclear staining are often not highly
sensitive to fluorescence bleed-through but the issue should be
considered when identifying a pair of staining reagents.

6.1.4 In general, the staining reagents should not directly
interact with the material on which the cells are adhered. If use
of the staining reagent with a test material results in a
high-level fluorescent background, it is possible that contrast at
the cell edge will not be sufficient for edge detection with
image analysis techniques. Control experiments that evaluate

the level of fluorescent background on materials after staining
can aid in selecting the most suitable staining reagents for these
measurements.

6.1.5 It is desirable that the fluorophore labels are not
sensitive to cell fixing and handling conditions, and that the
stain does not exit the cell after extended periods of time. This
criteria significantly improves the robustness of the morphol-
ogy measurement as cell can be prepared and stained at one
point in time and analyzed in another point in time.

6.1.6 It is desirable that the fluorophore labels are relatively
photostable so that a sample can be reimaged with little change
in the microscope settings. This property improves the reliabil-
ity of the image analysis procedures that are used to extract
data from the images.

6.2 Cell Sample and Substrate Preparation—Test cells are
typically removed from a maintenance flask by trypsinization
or other de-adhesion procedures and then seeded on the test
surface. The cells are allowed to adhere to the test surface for
a controlled number of hours before the cells are fixed, stained,
and imaged.

6.2.1 Care must be taken to ensure that a suspension of
single cells (and not clumps of cells) is achieved during
de-adhesion/harvesting to increase the probability that cells
seeded on the test substrate at low density will be isolated from
other cells. This condition will provide the most accurate single
cell morphology measurements. If large numbers of cell
clusters are observed on the substrate, the ability to measure
the distribution of cell spread areas may be compromised, but
it should still be possible to measure the average spread area
per cell

6.2.2 The cell density at several locations on the sample
surface should be examined by phase or other microscopy
modes to ensure that homogeneous cell adhesion over the
substrate was achieved during seeding. If this is not the case, it
is possible that the measurements described in this document

TABLE 1 Commercially Available Fluorophores that are Useful for Cell Morphology MeasurementsA

Fluorophore reagent
Type / Names

Probe
Features

Target References

Fluorescent lipids and detergents (such
as DiI, FITC-DMPE, Texas Red-DMPE)

Integrate into a lipophilic structure;
spontaneous insertion into cellular
membranes

Phospholipid bilayer; lipid structures in
cells

(9)

Fluorescent maleimides (such as
Fluorescein-C2-maleimide, Cy5-
maleimide CPM, dylight-maleimide)

Very reactive to free thiols under
physiological pH; labels cytoskeleton
and edges of cells; several fluorescent
derivatives of maleimides are available

Free thiol-containing proteins and
smaller molecules

(1), (4), (9)

Fluorescent succimidyl esters
(Fluorescein-NHS ester, ROX-NHS
ester, etc.)

Can become inactive in physiological
buffer at neutral pH

Free amine groups on intracellular
proteins and other molecules

(9)

Nuclear fluorophores (such as DAPI,
Hoechst 33342, DRAQ5)

For fixed and live cells; only fluorescent
when complexed to DNA

Nuclei (10), (11)

Affinity-based fluorescent reagents
FITC-phalloidin, Texas Red-lectins) and
other commercial staining reagents (cell
tracker, cell mask)

For specific ligand targeting (for
example, polymerized actin, cell
membrane polysaccharides) and other
cellular components

f-actin, cell surface glycoproteins; other
proteins and cellular components

(12)

AThe information in this table is a compilation of several staining systems that have been used to highlight cell edge and nuclear features. The table is not meant to specify
the quality and performance of a particular stain.
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may be biased by the selected area of a test substrate that is
being examined during imaging.

6.2.3 It is important to consider the time-dependent mor-
phology changes that occur after the cells are seeded on the
sample surface. At early time points, the cells are likely round
and will begin to spread on the surface. At later time points, the
cells will be fully spread and depending on the cell type, the
cells will begin growth and division processes. It is critical to
establish a test incubation time that provides a stable measure-
ment end point. For some cell lines such as NIH-3T3 and A10
cells (see Table 2), 17 to 24 h provide reproducible measure-
ments (3, 3).

6.2.4 During the test incubation times, it is possible that
cells will divide. Cell clusters will form (single cell object with
multiple nuclei) depending on if newly divided cells migrate
away from each other. The procedures discussed here can
detect cluster formation in the cell population (7).

6.2.5 Table 2 provides recommendations of seeding densi-
ties for several cell lines representative of primary cells and
cell lines that are used in the laboratory.

6.2.6 If the test substrate has the tendency to adsorb
significant quantities of fluorescent reagent (that is, a collagen
gel or other hydrogels), the background staining intensity
levels will be high and may reduce the sensitivity of the cell
edge detection procedures. Robust edge detection with image
analysis software requires high contrast staining at the cell
edge (8). This is determined by differential staining between
the cells and the underlying substrate. Solid surfaces often
provide the highest contrast due to the ease of rinsing the stain
from the substrate surface. Thicker gels may require extensive
washing to reduce the background staining levels to values that
are appropriate for image segmentation (13).

6.3 Fixation and Staining:
6.3.1 The measurements described here generally require

that the cells are fixed before staining. The effect of the fixing
procedure on the shape and integrity of the cells should be
examined with phase or other modes of microscopy before the
fixing procedure is used for a morphology measurement. For
example, in some cases, rinsing cells with buffer before the
addition of a fixative may dislodge or partially destroy the cells
adhered to a surface. Solvent and other highly-reactive cross-
linkers may affect morphology. Fixation by 1 % to 4 %
formaldehyde in phosphate buffered saline or microtubule
stabilizing buffer (4)is often acceptable. Permeabilization,
which may be required for staining can often be achieved with

low concentrations (~0.1 %) Triton X-100 without a significant
loss of morphology properties (1)

6.3.2 After the cells are fixed, they are often immediately
treated with nuclear and cell lipid or protein stains. It is often
useful to assess staining protocols on trial cell experiments to
ensure that accurate cell edge and nuclei discrimination can be
achieved by image analysis methods. The staining conditions
are sufficient if appropriate and repeatable edge detection with
image analysis software can be achieved. If cell edge staining
does not have sufficient intensity, increased incubation times or
increased stain concentration in the protocol may be useful.

6.3.3 Stained samples are then often mounted on micros-
copy slides with the use of mounting media. It is critical to
ensure the mounting media contain both anti-bacterial reagents
(for example, sodium azide) that prevent sample contamination
and anti-fade reagents that can reduce photobleaching of the
fluorescence sample.

6.4 Microscope Preparation and Imaging:
6.4.1 Samples are typically imaged on a fluorescence mi-

croscope fitted at with a CCD camera and filter cubes for
fluorophore visualization and a low magnification objective
(for example, 10×) with an appropriate NA (for example, NA
> 0.25). For best statistical results, stained cells should be
imaged with an automated fluorescence microscope. These
microscopes are fitted with a motorized x-y-z stage, automated
focus software, motorized filter wheels, CCD camera, and a
computer that is capable of controlling stage movement and
image collection (2). The automated microscope facilitates the
unbiased imaging of a large number cells on the substrate,
which can assure the adequate sampling of the cell morphology
data extracted from cell images. If manual image collection is
used to assemble cell images, care should be taken to minimize
bias during selection of fields to image. Resampling procedures
that evaluate measurements from a large populations of cells
can be used to determine the minimum number of cells that
should be measured on a substrate.

6.4.2 A critical issue for collecting cell images with fluo-
rescent microscopy is the need for flat-field correction. Most
microscopes are illuminated by arc or LED lamps. Although
many methods such as diffusers, liquid light guides, and
defocusing are used to diffuse the excitation lamp homoge-
neously over the sample illumination area, it is likely that the
illumination intensity over the collection field visualized by the
CCD camera is not constant. A routine artifact is that the center
of the collection field is brighter than the edges of the field.
This results in higher cell edge contrast in the center of the field
(i.e. higher cell pixel intensities) than the edge of the field. This
effect can significantly affect the image analysis method that is
used to extract cell spreading area measurements from cell
images. Flat-field correction should be used to improve the
reliability of the image analysis techniques (14), (15).

6.5 Image Analysis:
6.5.1 Once the images are collected, they must be analyzed

with image analysis tools. Several open-source and commer-
cial packages are available for this task. A very powerful
package is the ImageJ, which is an open-source image analysis
platform written in JAVA available from the NIH at http://

TABLE 2 Suggested Seeding Density for Various Sized Cells

Cell Type
Average

Diameter, (µm)
Seeding Density,

cells/cm2

NIH 3T3A 30-50 1100
A10B 50-100 800-1000
hMSCC 40-60 500-800E

UMR106D 20 1500
AMouse fibroblast.
BRat aortic smooth muscle.
CHuman marrow derived stem cells (#220R, Tulane Center for Gene Therapy).
DRat osteosarcoma.
EDepending on passage.
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rsb.info.nih.gov/ij/. The main requirement of the image analy-
sis software is that it must be able to open the images collected
with the microscope. The basic procedure to analyze the
images is as follows: (1) use an image analysis technique that
best identifies the edge of the cell in the images of the stained
cells; (2) use an image analysis technique that best identifies
the edge of the nucleus in the images of the stained cells; (3)
use mask overlay techniques to identify the number of nuclei in
each detected cell object; and (4) quantify features in the image
such as cell object area and the number of nuclei per cell
object. A sample macro that can be used with ImageJ software
is described in X2.1.6.1. Cell area measurements extracted
from image are highly dependent on the edge detection
algorithm used during image analysis. Manual threshold-
selection and histogram-based algorithms such as K-means (n
= 4 or 5) can provide good segmentation of the cell objects (8).

6.5.2 To convert the pixel dimensions of the cell objects into
physical spatial dimensions, a horizontal and vertical conver-
sion factor shall be measured for the CCD camera on the
microscope system. A standardized microscope calibration rule
traceable to a NIST or similar length measurement standard
can be purchased at several commercial optical suppliers and
used for this purpose.

6.6 Statistics and Analysis:
6.6.1 There are two main metrics that can be reported from

this type of measurement. The first is average cell-spread-area
per cell, which is derived by dividing the total cell spread area
measured in all the images by the number of nuclei measured.
This metric is often recorded if there are large fraction of cell
clusters identified in the cell population. This may occur with
certain cell types. A second metric that can be reported is the
distribution of cell spread areas for individual cells in the
population. Cell spreading area data can be plotted as a
histogram or as a cumulative distribution (16). The histogram
can be generated using Microsoft Excel or similar spread sheet
functions. An example of a histogram representing the distri-
bution of spread areas for NIH 3T3 fibroblast cells on a tissue
culture polystyrene surface is shown in Fig. X1.1.

6.6.2 It is important to consider how many images are
required to ensure an adequate number of cells are being
sampled for statistical robustness in the spreading area mea-

surement. Techniques to evaluate the error due to undersam-
pling (for example, resampling statistics) can be useful for
addressing this issue.

6.6.3 Statistical testing between the summary statistics, such
as the mean of the cell-spread area per cell, can be achieved
with standard means testing (that is, student’s t-test). The use of
replicate data sets is required to provide information on the
uncertainty in this measurement. More sophisticated statistical
analysis procedures that take advantage of the shape of the
distribution of individual cell spread areas can also be consid-
ered (16).

7. Future Considerations

7.1 Cellular morphology can be affected by a large number
of signaling pathways with in a cell. If changes in cellular
morphology measurements are not detected during an
experiment, it does not indicate that intra-cellular signaling
pathways are not changing. For example, if cell cycle is halted,
it does not necessarily indicate that cellular morphology will
change immediately. There are several classes of cell mor-
phologies on a substrate (such as elongation, rounding, leading
edge formation, etc.). Future studies to correlate activation of
known pathways and their effect on cell morphology over time
would be useful to aid in interpreting the cause of a morphol-
ogy change.

7.2 To convert the measurements described in this guide to
a test method, significant robustness testing is required to
identify the experimental factors that must be specified for
reducing variability in the cell spread area measurement.
Furthermore, interlaboratory comparisons (for example, round-
robin testing) using common cell lines and culture conditions
would be useful for establishing other experimental parameters
that should be controlled or measured before a standard test
method can be developed.

8. Keywords

8.1 automated microscopy; cell morphology; cell cultures;
segmentation; image analysis; fluorescence microscopy; cell
staining; biomaterials; cytotoxicity; tissue engineering; cell
therapy; stem cells; differentiation; quality control

APPENDIXES

X1. A DETAILED PROCEDURE FOR GENERATING A CELL SPREAD AREA MEASUREMENT

X1.1 Scope

X1.1.1 This is a detailed procedure for determining the
spread area of fixed cells with fluorescence microscopy. This
example provides the details of sample preparation, cell
labeling, imaging, and analysis experiment with a specific
combination of fluorophores for whole cell and nuclear label-
ing. These fluorophores have been used for measurements in
several publications (1-8). This detailed procedure can be used
to guide the development of cell spread area measurement in
individual laboratories.

X1.1.2 This experiment describes a cell spread area mea-
surement of A10 rat smooth muscle cells on a tissue culture
polystyrene substrate.

X1.2 Hazards

X1.2.1 Reagent hazards are stated in the product MSDS.
Sodium azide (NaN3), which is used as an anti-bacterial
reagent in the mounting media, is included in this procedure.
This compound is highly toxic. No additional hazards have
been identified during the procedure steps.
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X1.3 Procedure

X1.3.1 Cell Seeding—A10 cells are removed from tissue
culture polystyrene flasks by trypsinization, rinsed with
medium, and plated in medium onto tissue culture polystyrene
substrates at a cell density as described in Table 2.

X1.3.2 Cell Fixation—After incubation for 24 h, cells on the
test substrates are washed with warm PBS, fixed in 1% (v/v)
formaldehyde in DPBS (30 min) at room temperature,
quenched in 0.25% (m/v) NH4Cl in DPBS (15 min), and rinsed
with DPBS containing 0.02% (m/v) sodium azide (DPBS/N3).
Cells can be stored at 4°C for at least a week under these
conditions.

X1.3.3 Cell Staining—After cells are fixed and rinsed, the
supernatant is removed and the cells are permeabilized and
stained (2 h) with a fresh solution of 2 µg/mL Texas Red-C2-
maleimide and 1.5 µg/mL of 4’,6-diamidino-2-phenylindole
(DAPI) dissolved in 0.1% (v/v) Tx-100 in DPBS. The solution
should completely cover the cells and the samples can be
placed on a rocking table. Longer incubation times can be used,
but the incubation time should be constant for all samples in a
single experiment to minimize variations in the imaging
settings for each sample. The stained cells are rinsed once with
DPBS/N3, 3% (w/v) bovine serum albumin in DPBS/N3 for 10
min and DPBS/N3 again. The stained cells can be stored for
several days at 4ºC under these conditions.

X1.3.4 Sample Mounting—Fixed and stained cell samples
can be mounted on a glass slide with traditional mounting
medium or kept in a petri dish containing DPBS/N3. The use of
anti-microbial reagents such as DPBS/N3 is critical for ensur-
ing that sample damage does not occur during prolonged
storage. Additionally, a mounting media with anti-fade prop-
erties that reduce photobleaching should be used during sample
mounting.

X1.3.5 Microscopy/Automated Microscopy—To adequately
sample the substrate for cell morphology measurements, it is
important that significant numbers of cell images are collected.

First, a grid of non-overlapping locations on the substrate is
generated using an automated microscope. The microscope
autofocuses on the more photostable TxRed whole cell stain
and then collects an image of the cells and the nuclei with a low
magnification objective (10× magnification, NA = 0.25). The
microscope cycles through the grid of locations for the cell
response image collection. Exposure time used for the CCD
camera image collection should be sufficient to generate a high
level of edge contrast at the cell and nuclear edge. This will
need to be determined by ensuring image analysis routines can
adequately identify the cell edges.

X1.3.6 Image Analysis—Cell segmentation routines are
used to identify cell and non-cell pixels. For the TxRed and
DAPI staining described in this example, simple manual
thresholding or K-means (k = 5) can provide good segmenta-
tion of the cells and nuclei (7). An example of a macro written
for ImageJ open source image analysis software to analyze the
TxRed and DAPI stained TxRed cells is shown in X2.1.6.1.
This procedure first identifies all cell objects in the TxRed
stained images and all nuclei in the DAPI stained images. The
macro then overlays the whole cell mask over the nuclei mask
and the nuclei within each cell object are counted. The macro
then reports cell spread area for each object and the number of
nuclei for each cell in the image. The report table is then cut
and pasted into a spread sheet program for further analysis.

X1.3.7 Quantitative Comparisons—Conventional statistical
testing (that is, students t-test) can be used to evaluate changes
in summary statistics such as the average cell spreading area
per cell (4). Distribution comparison statistics should be used
to compare cell area distributions (16). Replicate measure-
ments are used to quantify the uncertainty in the cell spread
area measurement.

X1.4 Potential Sources of Variability

X1.4.1 Image Analysis—Studies indicate that automated
classification algorithms (such as K-means) can provide excel-
lent segmentation of morphology images with high contrast

FIG. X1.1 Example of Histogram Data Generated from Morphol-
ogy (Projected Cell Area) Analysis of NIH 3T3 Fibroblasts Grown

on TCPS Under Normal Conditions
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cell edge staining. Other pixel classification techniques, such as
manual thresholding, can also provide excellent segmentation
with high quality images. It is important to visually evaluate
(for example, expert opinion) the segmentation procedure to
ensure that adequate cell and non-cell pixels are identified (8).

X1.4.2 Cell Sampling—Due to the broad distributions of
cell spread areas that are often measured, it is important that an
adequate number of cells are sampled to minimize measure-
ment error due to undersampling. In some cases, it is possible
to use resampling procedures to determine a minimum number

of cells to measure. For example, there is little variability in the
mean and variance of the individual histograms referenced in
X2.2 and Fig. X1.1 if more than 200 cells are used during the
analysis.

X1.5 Report

X1.5.1 Data can be reported as average values with uncer-
tainty measurements or histogram-based distributions with
uncertainty values on each histogram bin. Alternatively, the
distribution data can be presented as a cumulative distribution
as described in Reference (16).

X2. DETAILED PROCEDURE FOR GENERATING A CELL SPREAD AREA MEASUREMENT USING IMAGE ANALYSIS
SOFTWARE

X2.1 Scope

X2.1.1 The following is a procedure for analyzing the
images described above with ImageJ analysis software. Similar
procedures can be performed in many image analysis plat-
forms. Therefore this procedure provides the general approach
to the image analysis.

X2.1.2 The corresponding TxRed (whole cell) and the
DAPI (nuclear) images should be placed in different directo-
ries. They should also be indexed so the ordering of the TxRed
images correspond to the order of the DAPI images. For a
small number of image files, this can be achieved by renaming
the files. For example, TxR.tiff.001, TxR.tiff.002, etc. and
DAPI.tiff.001, DAPI.tiff.002, etc. For a large number of files, a
batch renaming program can be used. Alternatively, the images
can often be stored with indices during image collection
depending on the software settings.

X2.1.3 In ImageJ, open the TxRed images with “File-
>Import->Image Sequence”. Browse to the directory holding
the TxRed images and double click on one of the image files.
ImageJ should open a stack of image files (see Fig. X2.1). To
segment the cells, use Image->Adjust->Threshold. Manually
select a threshold value that highlights the edges of the cells.
This step is critical for reproducible results. The high contrast
staining of the cell edge reduces the ambiguity associated with
threshold selection, but care is required to select a threshold
that adequately identifies the cell edge. Scan through the
images to ensure a suitable threshold value is chosen for all

cells. Once the threshold value is chosen, press Apply in the
threshold dialog box and answerYes when asked to process the
whole stack. The results should be black and white images of
the cells (see Fig. X2.2).

X2.1.4 The black and white whole cell mask images are
used to generate a list of cell objects in the ROI (region of
interest) manager. In ImageJ, click Analyze->Analyze Particles
to open the particle analyzer. Check Add to manager and
Exclude edges in the dialog box. The latter selection prevents
any cells on the edge of the frame from being included in the
analysis. In the size box, type 100-5000. This limits the size of
the cell objects to those that are in the range of real cells. Very
small object and very large objects will not be considered in the
analysis. Click OK to start the analysis and a ROI manager
should open with a region of interest for each cell object. These
ROIs will be used with the DAPI images for nuclei counting in
the next step. Close the Tx-Red image stack.

X2.1.5 In ImageJ, open the DAPI images with File-
>Import->Image Sequence. Browse to the directory holding
the DAPI images and double click on one of the image files.
ImageJ should open a stack of image files (see Fig. X2.1(b)).
To segment the nuclei, use Image->Adjust->Threshold. Manu-
ally select a threshold value that highlights the edges of the
nuclei. The threshold value should be set to detect each of the
nuclei, but it does not need to precisely identify the edge of the
nuclei. This consideration reduces the stringency of the thresh-
old value that is used to identify the nuclei. Scan through the

FIG. X2.1 TxRed (a) and DAPI (b) Stained A10 Smooth Muscle Cells
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images to ensure a suitable threshold value is chosen for all
cells in the image stack. In some cell types, nuclear intensity
varies significantly. It is important to identify a threshold value
that detects most nuclei. Once the threshold value is chosen,
press Apply in the threshold dialog box and answer Yes when
asked to process the whole stack. The results should be black
and white images of the nuclei (see Fig. X2.2(b)).

X2.1.6 A macro for image analysis is shown in X2.1.6.1.
Copy the text into notepad.exe or similar software and save it

as a text file in a known location. To run the macro in ImageJ,
click Plugins->Macro->Run. Select the macro text file and the
nuclei counting should begin. A log dialog box indicating that
the macro has started should appear. Yellow outlines of cell
objects should appear on the DAPI images during the analysis.
On a fast computer, these yellow outlines may not be visible.
When the analysis has completed, a table should appear that
contains the results of the nuclei counting.

X2.1.6.1 Image Analysis Macro for Imagej Software:

//Macro was written by JTE and MH for ASTM Cell Morphology Document
//Nov 7, 2007
//A stack of TxRed labeled images are opened and thresholded to black and white mask images.
//Particle analyzer (exclude edges) is ran on the TxRed labeled images and the the regions of interest are stored in the ROI manager.
//The TxRed images are closed and the corresponding of DAPI images are opened and thresholded to black and white mask images.
//This macro is then executed.
//This macro steps through the ROI manager and counts the number of DAPI objects in each cell ROI.
//The macro then writes the area of the TxRed Object and the number of DAPI stained nuclei to the results table
var nucminSize =20; // the minimum size of a nucleus object
nold=0;
num = roiManager(9count9); //number of cell objects detected
areacell = newArray(num); //arrays for measured data
frame = newArray(num);
nuc = newArray(num);
print (9Analyzing 9+num+9 regions of interest from TxRed stained images9); //note indicating function
for (i=0; i<num; i++) // loop through ROIs
{
roiManager(9select9, i);
s=getSliceNumber(); //get frame information
getStatistics(area); //get area of cell
run(9Analyze Particles...9, 9size=20-Infinity circularity=0.00-1.00 show=Nothing exclude slice9); //count nuclei
no=nResults; //cumulating number of nuclei
frame[i]=s; //save frame area
areacell[i]=area; //save cell area
nuc[i]=no-nold; //save number of nuclei/cell
nold=no;
}
//print results table
run(9Clear Results9);
for (i=0; i<num; i++)
{
setResult(9Frame9,i,frame[i]); //print results to table
setResult(9Area9,i,areacell[i]);
setResult(9# Nuc9,i,nuc[i]);
}
updateResults(); //show results
selectWindow(9Results9); //bring results to front - this data should be pasted into a spread sheet program

FIG. X2.2 Cell bodies (a) and Nuclei (b) After Manual Thresholding in ImageJ
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X2.1.7 The results table that is generated has three columns
labeled as follows: Frame #, Area, and # Nuc. Frame #
indicates which frame the cell object was located. Area is the
area of the TxRed labeled cell object (whole cell area). # Nuc
is the number of nuclei detected in the cell object. This table
can be directly cut-and-pasted into a spreadsheet program such
as Microsoft Excel. The cell spread area calculations can be
performed with this data.

X2.2 Fig. X1.1 is an example of histogram data generated
from morphology (projected cell area) analysis of NIH 3T3
fibroblasts grown on TCPS under normal conditions. The
histograms represent nine different areas of a 10 cm polysty-
rene dish. One hundred fields in each area (approximately 1000
cells) were imaged using an automated microscope. The scale
bar represents 30 µm.
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